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Overview

Document Database is a program that keeps track of all your notes, letters, and other documents.    In fact
this program will hold information about almost anything, and keeps it all in one neatly organized place. 

Document Database has a word processor built right in, complete with a spell checker containing 
120,000 words!    The difference between this word processor and most others is that with Document 
Database, you can easily find your documents again.    The other difference is that Document Database is
simple to learn and easy to use!    And still another big difference is the price!

Find any text anywhere in the database simply by telling the program what text to search for.    Document 
Database then displays all documents containing this text, and lets you easily view and edit them.

A unique feature lets you group your documents into any categories you want, then view just the 
documents in these categories.

Document Database even includes a sophisticated feature that lets you specify just about any criteria you
can think of to find certain groups of records.    You can then view, edit, or print just the records you 
selected.

You can easily select one or any number of records for viewing, changing, or printing.    You only have to 
deal with the records you want, not the entire database.

In addition to keeping all your documents in one database, you can export any document to a Rich Text 
Format file (RTF) so you can use it with almost any word processor, with all formatting intact.    You can 
also import RTF files from your word processor, and import or export ASCII text files.

Document Database even lets you include graphics in your documents.    This program is all the word 
processor most people need, but it is much more than a word processor, giving you the full power of a 
database.    All this in an easy-to-use tool with a price that is almost laughable.

Document Database is an incredible value.    There is nothing like it on the market, and the price is 
ridiculously low for a tool with this much power and utility.



Categories

You create a category by clicking on the Category button and adding a new category.    You can assign 
each record to categories you create.    This is great for keeping track of groups of records. You can then 
view and print just the records in that category.    You can display just the records in that category by 
double clicking on the category name on the same screen.    

Note:
If you are displaying records in a certain category, any records you add are automatically assigned to that 
category.

To assign a record to a category, highlight the record you want on the first Document Database screen 
(the screen with the colorful icons at the top), then click the Assign button.    The Category Assignment 
screen appears.    Double-click on a category in the box on the left side of the screen, and that category 
will be assigned to the current record.    Double-click on a category in the box on the right side of the 
screen and that category assignment will be removed from the current record.    You can assign a record 
to as many categories as you want.

Assigning many records to a category, all at once
You can easily assign many records to one category at the same time, or remove many records from one 
category.    Select and display just the records you want (see the Selecting Records topic), then choose 
the option "Assign Many Records to Category" or "Remove Many Records from Category" on the Edit 
menu.    On the next screen displayed, select the category from the list and choose the appropriate button.



The Clipboard

Copying the Notes to the Clipboard
Clicking the Clipboard button copies the Record Name, Alternate Name, and Notes from the current 
record to the Windows Clipboard.    You can also hold down the Ctrl key and press the letter "N" to do the 
same thing.

After copying this data to the Clipboard, you can paste this text into any Windows application by simply 
holding down the Ctrl key and pressing the letter "V".    The data from the three Document Database fields
will then appear at the cursor location.

Copying only selected text
To copy only selected text to the clipboard, first select the text by highlighting it with the mouse (hold down
the left mouse button while moving the mouse over the text) or the keyboard (hold down the Shift key 
while pressing the left or right arrow keys).    Then hold down the Ctrl key and press the letter "C".    This 
will copy the selected text onto the Windows Clipboard.    You can also copy and delete text at the same 
time, which is call "cutting" the text.    Hold down the Ctrl key and press the letter "X" to cut text into the 
clipboard.    Once you copy or cut the text, paste the text using the Ctrl-V key combination described in the
previous paragraph.    These keystrokes work this way in all Windows applications, not just 
Document Database.    This lets you copy data from other programs and put it into Document 
Database.



Compact Database

Periodically, especially if you delete a lot of records, you should click on the Compact Database icon in 
the Document Database program group.    Compacting your database removes any fragmentation, 
deletes unused areas within your database, and usually makes the database file smaller.    

The Compact process creates a new, compacted copy of your database file and calls it DOCDB.NEW.    It 
then renames your old database file to DOCDB.BAK.    Then it renames DOCDB.NEW to DOCDB.MDB.    
This insures that if something goes wrong with the process (highly unlikely!), a copy of your old database 
still exists, and simply needs to be renamed back to DOCDB.MDB using either Windows File Manager or 
the DOS rename command.

Because this process creates a second copy of your database, you need to have enough space on your 
disk to hold the second copy. 



Contacting the Author

You can contact the author of Document Database as follows:

By U.S. Mail:
Michael Paulick
P.O. Box 935
Conifer, CO 80433
U.S.A.

CompuServe id:
70640,1614

Internet address:
70640.1614@compuserve.com

Phone support is not provided.    I respond promptly to all e-mail and letters.    Please be aware that some 
e-mail gets lost!    If you do not hear from me promptly, send your message again!    Once or twice a year 
I'll take a one-week vacation, which is the only time you might have to wait longer for a reply.    I do not 
have a VISA or MasterCard merchant account, so I cannot accept credit cards.



The Edit Screen

The Edit screen consists of the following components:

The Record Name field
This is where you enter the unique name you want to call this record.    This name can be up to 255 
characters long, and can include spaces.

The Alternate Name field
This is another name you may want to give this record.    This name can be up to 255 characters long,
and can include spaces.    It does not have to be unique, and you can use this field to indicate the type
of data that is contained in this record.    You can then sort by this name or look up all records 
containing this name.    For example, if your document is a letter you wrote to someone, you can put a
person's last name in here.    Then you can quickly and easily find all letters you wrote to this 
person.

The Notes field
Use the Notes field to describe what this document contains if you want.    You can type up to 32,000 
characters of Notes in here, for each record.    You can even use this field for any data that does not 
have to be formatted, instead of using the full word processing window.    Double-click your mouse 
anywhere within the Notes field, and the field will expand so that you can see more text at a time.    
You can change the font used in the Notes field, by choosing the menu option "Specify Font for 
Notes" back on the Edit menu of the previous screen, which is the first screen you see when you start
Document Database.    The Reports menu on the first screen is where you would go to print the data 
in the Notes field.

The Close button    
Press this button to save any changes and to return to the previous screen.

The Cancel button    
Press this button to abandon any changes you have made and to return to the previous screen.

The Toolbar

The toolbar looks like this:

The toolbar is used to apply formatting to any text you have selected in the word processing window.    
The word processing window is the entire area of the screen which appears below the toolbar and ruler
(more about the ruler later).    This is where you type and format your documents.    

The toolbar is made up of several components and buttons.    To use it, you first select text in the word 
processing window, then you select a button or font from the toolbar.

Selecting Text
To select text in the word processing window, you move your mouse to the beginning of the text, 
press and hold down the left mouse button, and move the mouse over the text that you want to select.
As you move the mouse, the text you are dragging the mouse over will be highlighted.    When you 
release the left mouse button, that text is then selected.    You can also select text with the keyboard 
by holding down the Shift key as you move the cursor using the arrow keys on your keyboard.

Refer to the following descriptions of each toolbar component:



The Font Selection box.    This box is where you specify the font to be used for your selected text.    Click 
the mouse on the arrow at the right of this box to list all the fonts installed on your computer, then select 
one from the list.

The Font Size box.    This box is used to specify the size of the font, in points.

 
The Bold, Italic, and Underline buttons.    These three buttons are used to make your text boldface, 
italic, or underlined, respectively.

The Text Justification buttons.    These four buttons are for justifying your text, which means they 
determine how your text will be aligned with the page margins.    In this example, the left button is pushed 
down.    It has a picture on it that shows lines of text aligned with the left margin of the page.    The next 
button is for right-alignment.    The 3rd button from the left is for centering text between the margins, and 
the right-most button is for aligning the text with both margins.    It does this by inserting extra spaces 
between each word in order to make the right margin always line up.    It only does this on each line of text
that is a full line.    These justification buttons work on the lines of text you have selected or if you have not
selected any text, they work on the entire paragraph that the text cursor is positioned in.    A paragraph is 
all text that wraps to a new line without you inserting a carriage return or new line.    This can be one line 
or many.

The Tab-Alignment buttons.    These four buttons are for aligning text with tabs.    These work in 
conjunction with the ruler, which is described below.    Select one of these buttons before setting a tab.    
From left to right, the buttons are for:

Left-Aligned tab
Right-Aligned tab
Decimal-point Aligned tab
Centered tab

These four tab alignment options determine how the text you enter after tabbing will be aligned in relation 
to the tab you set. 

To set a tab, select one of the four tab alignment buttons (the left one is most common), and then click at 
the point on the ruler where you want the tab positioned.    You can re-position a tab by dragging it to a 
new position on the ruler.    You remove a tab by simply dragging it completely off the ruler to either the left
or right. 

The ruler looks like this, and is located just below the toolbar:

The small dark triangles on the left side of the ruler (they look like this:  ) are used to indent lines of text. 
Dragging just the top half triangle will indent the first line of text in the current paragraph, and dragging the
bottom half indents all lines in the paragraph after the first line.    If you drag the bottom half, the top half 
moves with it.    Type a few lines of text and then play around with this to fully understand it.

The Save button 
The Save button contains a picture of a diskette and is located on the right side of the toolbar.    Pressing 
this button immediately saves any changes you have made.    You can also save your changes by 
choosing the Save Document option from the File menu, or by pressing Ctrl-S on your keyboard.    Your 
changes are also saved when you press the Close button.

The Print button 
The Print button has a picture of a printer on it and is located on the right side of the toolbar.    Pressing 
this button takes you to the print dialog screen which lets you print your document.    You can also print 
your document by choosing the Print Document option from the File menu, or by pressing Ctrl-P on your



keyboard.

The Spell Check button 
The Spell Check button starts the Spelling Checker.    You can also start the Spelling Checker by choosing
the Spell-Check menu, or by pressing Ctrl-K on your keyboard.

Special keyboard commands
To insert a new page in your document, press the Ctrl and Enter keys. 
To insert a non-breaking space, press Ctrl, Shift, and Spacebar

The menu choices
Each item on the menu at the top of the Edit Screen should be self-explanatory, especially after you 
choose each item.    

The File menu lets you save, print, or preview your documents, and allows you to import text or graphics 
into a document.    You can also paste text or graphics into a document using the Windows Clipboard.    
The file menu also lets you export your document to a file.    To export your document as a separate file, 
see the Export Document as File topic.

The Edit menu lets you cut and paste text and graphics to and from the Windows Clipboard, and allows 
you to find and replace any text in your document.

The Format menu provides additional options for formatting text, paragraphs, and pages.

The Spell-Check menu option implements the spelling checker, which checks for misspellings in your 
document.

The Help menu option displays the help text you are now reading.



Error Messages

Incompatible Database Version
You have an old, incompatible version of file VBDB300.DLL in your WINDOWS\SYSTEM directory.    
Delete this old file from your hard disk and re-install Document Database.    The newer version of this file 
will then be installed.

Couldn't lock file: SHARE.EXE not loaded
MS-DOS file sharing lock count exceeded
These messages should not occur if you are using Windows 95 or Windows for Workgroups.
If you get a message similar to those above, here's what you need to do:

Using the Windows Notepad program, the DOS Edit program, or some other text editor, open your 
Windows SYSTEM.INI file.    This file is usually located in your C:\WINDOWS directory, so the file 
name you would open is:

C:\WINDOWS\SYSTEM.INI

Find the line in your SYSTEM.INI file that says: 
[386Enh]

Add a new line after that line that says:
DEVICE=VSHARE.386

Save your changes to the SYSTEM.INI file.

Important:
You will then need to totally end Windows and restart it before this change will take effect.
This should solve the problem. 

For your information, the VSHARE.386 file is a virtual device driver required by some Windows 
programs to manage the sharing of files among programs.    During the Document Database 
installation, the Setup program should have installed this file in your Windows System directory if it 
was not already there and if the program determined you needed it.    If you installed Document 
Database some other way, you may get these messages.

The VSHARE.386 program replaces the DOS SHARE.EXE program for use by Windows programs,
and is superior to the DOS version, since it dynamically adjusts for the number of file locks needed. 
DOS programs that share files still require SHARE.EXE.

Invalid property value
This message can occur when printing a report or trying to add or edit a document, and is almost always 
caused by Document Database looking for a font that does not exist on your computer.    Change the font 
by selecting the Document Database Edit menu and choosing the "Specify Font for Notes" option, then 
select an existing font and save it.

Tips when you get any error
Whenever you get an error or weird behavior, close all your Windows applications, then shut down and 
restart Windows.    The memory used by Windows ends up getting corrupted the more it is used, and the 
only way to set things right again is to shut down Windows.    After doing this, start Document Database 
and try the operation again. 



Export Document as File

Normally, you save your documents in the database.    However, you can also save your documents as 
separate files outside of the database.

This option is available in the File menu on the Edit screen.

You can save your documents as two different file formats:
1. ASCII text file
2. Rich Text Format (RTF) file

To preserve the formatting of your text, save as an RTF file.    This file can be read by most word 
processors, with all formatting intact.

If you save your document as an ASCII text file, any formatting you might have done to the text in the 
word-processing window will not be exported, since an ASCII text file does not support text formatting.



Filtering records

To view only certain records in your database, click the button.    The "Specify Record Filter" screen 
appears.    A record filter is simply criteria you specify to limit the records displayed.    You should also see 
the Find help topic, which is another way to view only certain records. 

If you are familiar with SQL, this should be easy.    Just specify a SQL WHERE statement, leaving out the 
word WHERE.    If you're not familiar with SQL syntax, it's still easy!    Simply pick a field from the list, or 
type a field name in the box.    After the field name, specify a comparison operator, such as =, <, >, <> (not
equal), or like.      Then enclose the value you want to compare the field to in quotes.    For example, to 
show all records containing an AlternateName equal to either "Optics" or "Furniture", your criteria would 
be:

AlternateName = "Optics" or AlternateName = "Furniture"
Notice the word "or" in the above example, which allows you to check for two values at once.    If you 
substitute the word "and" instead of "or" in the above example, you will not find any records since the 
AlternateName field cannot be equal to both values in any one record.

You use the like comparison operator together with asterisks * to find any combination of characters in a 
certain field.    The asterisk serves as a wild card character.    In other words, any character (or any 
number of characters) match the asterisk.    So if you want to find all records where the Notes field starts 
with "mac", you would specify the following criteria:

Notes like "mac*"
Putting the asterisk as the last character after "mac" means that all records whose Notes field starts with 
"mac" will be found.    For example, Notes starting with "MacAllister", "MacDonald", or "Mack" will match 
this criteria.    If you put the asterisk as the first character instead of the last (Notes like "*mac"), any 
notes ending with "mac" will be found, such as "Tarmac".      Placing an asterisk at both the front and the 
back of a character string (WPText like "*mac*") will find records with "mac" anywhere in the word-
processor text field, such as "Belmacelroy".    This is especially handy for finding some word or phrase in 
your formatted word processing text, or in the Notes field.    You can also place the word "not" in front of 
the "like operator, such as 
WPText not like "Mac*"

Finding records with empty fields
Sometimes you may want to find all records which do not have any data in certain fields.    If you specify 
criteria that looks for actual blanks, such as AlternateName=" "    you will probably not find any records 
that match this criteria.    Instead, you should look for Null, such as AlternateName=Null.    This will find 
all records that have nothing in the AlternateName field.    Null is not the same as blank characters.    Null 
is the absence of data.    Blank spaces are actual data characters.

Important information about the DateUpdated field
If your criteria includes the DateUpdated field, surround the date with pound-sign symbols # instead of 
quotes.    For example:

DateUpdated > #12/25/96#
Since the DateUpdated field also includes the time, this also finds records updated on 12/25/96, in 
addition to after 12/25/96.    The time appears right after the date, like this: 12/25/96     9:02:43     AM  .    If you 
only specify the date and not the time, then "12/25/96 09:02:43 AM" is greater than just "12/25/96".    This 
is why if you ask for DateUpdated greater than 12/25/96, you will also get all records updated on 
12/25/96. 

Specifying a range of dates.      The   "Between...And..."   clause  
If you need to specify a range of dates, there is a special clause you can use in your filter criteria just for 
this purpose.    Suppose you want to find all records where the DateUpdated field is between 12/1/96 and 
12/31/96.    Your filter criteria would look like this:

DateUpdated between #12/1/96# and #12/31/96#





Find

To find a string of characters anywhere in your Document Database data, click the Find button, then type 
the string of characters you are looking for.    Document Database will search all fields and all records in 
the entire database and then display just those records that contain the characters you specified.    Since 
this requires a lot of searching, it could take some time if you have many records in your database.

The Find command is quite powerful, and allows the use of the wildcard characters * (asterisk),    ? 
(question mark), and # (pound sign).    These work similar to the wildcard characters in DOS.    The 
asterisk matches any number of characters, so th* finds the, there, and three, while *ow finds how, 
wow, and plow.    The question mark matches any single character, so h?t finds hat and hit.    The 
pound sign works like the question mark, except it matches any single number, so 2#4 finds 234, 214, 
294, etc.    The left and right square brackets [ ] match any single character within the brackets, and you 
can put multiple characters in there.    For example, d[oi]g finds dog and dig.

You may want to refrain from using these wildcard characters within your data to avoid confusing the Find
command.    However, you can match on these characters if they appear in your data by enclosing them in
square brackets.    For example, if you want to search for a question mark in your data, you would do a 
find on [?]



The Grid

Description
The Grid is the section of the first Document Database screen (the screen with the menu and toolbar) 
which displays the records in your database.    It is made up of rows and columns, and looks similar to a 
spreadsheet.    Each row contains all of the data for each person in your database.    Each column is a 
field in your database.    

Changing the appearance of the Grid
You have a great deal of flexibility in configuring the appearance and behavior of the Grid.    Many 
features are similar to a Windows-based spreadsheet like Microsoft Excel.    These features are listed 
below.

Rearranging Columns
You can rearrange the columns by dragging and dropping the column name to a new position.    Position 
the mouse cursor over a column name (such as Record Name), then press the left mouse button and 
hold it down.    Then move the mouse horizontally across the columns, and release the left mouse button 
when the column is in the position you want.    This is called "dragging and dropping".    Document 
Database will remember the changed column positions each time you run the program, until you change 
them again.

Resizing Columns
To change the width of a column, position the mouse cursor on the right edge of the column until the 
cursor shape changes to a double-sided horizontal arrow.    Then press the left mouse button and hold it 
down.    Then move the mouse either left or right to decrease or increase the width.    The column will then
stay this new width until you change it again.    If you change the column width to zero, that column will 
disappear from the Grid until the next time you start the Document Database program.

Allowing/Disabling Grid Editing
There is an option on the Edit menu to Allow Grid Editing.    When you choose this option, you can 
make changes to your data directly on the Grid.    When you choose this option, the menu selection 
changes to Disable Grid Editing, and choosing this will turn off this feature.    When Allow Grid Editing is 
enabled, you can edit your data by first clicking once on a record on the grid, so that row is highlighted.    
Then move the mouse cursor to the field you want to change, and click once.    The field will change color,
and you can type a new value in that field.    You can press the Esc key prior to moving the cursor off that 
field to cancel your change.    When you move the cursor off that field or row, the changed field will be 
saved.

There are a few fields, such as the Date Updated field, which appear on the Grid but cannot be changed.

Locking a column in place so it doesn't move when you scroll
Suppose you want to view or edit a column that is on the right-hand side of the grid.    When you scroll to 
the right, you can no longer see the Record Name field that helps you identify which record you are 
dealing with.    To solve this problem, you can split the grid in two so that you can see the fields that help 
you identify the record    (such as the Record Name column) on the left-hand side of the grid, while 
scrolling the right-hand side of the grid independently.    To do this see the next section, called "Splitting 
the Grid".

Splitting the Grid
You will notice a small rectangular black box (called the split box) which appears at the leftmost boundary 
of the horizontal scrollbar. In other words, this box is in the bottom left corner of the Grid.    When you 
move the mouse cursor over this box, notice that the cursor shape changes to a downward facing arrow 
attached to two vertical lines.    Once the mouse is positioned over this box, drag and drop this cursor to 
the right.    Dragging is defined as pressing and holding down the left mouse button while moving the 



mouse.    Dropping is defined as letting up on the left mouse button after the mouse is positioned where 
you want it.    Drop the cursor where you want the split to occur.

After dragging and dropping the split box, you will notice the Grid now appears as two grids side by side.   
You can now scroll each side of the Grid separately.    This lets you position a column such as Record 
Name on the left side of the Grid, while then scrolling to another column on the right side of the Grid.    
You can reposition the split by dragging and dropping the new split box that appears when you create a 
split.

You are not limited to just two splits.    You can create as many splits as you need by dragging and 
dropping the left-most split box.    This allows you to have three, four, or even more independently 
scrollable regions on the Grid.    This is very handy if you need to view certain columns that are not 
located right next to each other.

You can eliminate the split by dragging the split box all the way to the left.    The splits will also go away 
when you end Document Database and start it again.



Locate

To locate any record in your database, make sure the cursor is on the Locate box on the main Document 
Database screen (the screen with the menu and picture icons), then simply type a character in that box.    
Document Database will highlight on the Grid the first person it finds whose Last Name starts with that 
character.    If you type a second character, Document Database will find the first person whose Last 
Name starts with those two characters.    You can continue to narrow the search by typing more 
characters of the Last Name.    

If no person in your database matches what you typed, the current record highlighted on the Grid remains
the same.

The above example assumes that you have not changed the sort order, so your records are sorted by 
Last Name.    If you change the sort to another field, the Locate function will search whatever field you 
have sorted by.

If you sort by the Date Updated field, Document Database does not try to locate a record until you have 
finished typing a valid date.    A valid date does not have to contain the year.    If you type 12/3 Document 
Database will start searching for December 3rd of the current year. 

Note:
Refrain from typing double quote marks ( " ) in any field you intend to sort by and use the Locate feature 
with.    The Locate feature ignores double quotes, so typing a double quote in the Locate field will have no 
effect.    Certain special characters (like * and #) are also ignored.



Multiple Users and Multiple Databases

Use on a LAN
Document Database works great on a Local Area Network (LAN).    Multiple users can all share the same 
database simply by specifying the database name in the command line used to start Document Database 
(see below).    Record locking is handled automatically by the Microsoft Access database engine.

Important:
Use on a LAN requires an individual payment to the author for each person using Document Database.    
If you have more than 10 users, a site license is available.    Contact Michael Paulick for pricing.

Multiple Databases or Multiple Users Sharing the Same Database
Normally, your Document Database data file is located in the C:\DOCDB directory, and the name of this 
file is DOCDB.MDB.

Most users will not want to change this.    However, in some cases you may want to have several people 
sharing the same database, or multiple database files in different directories on your hard drive, while still 
having only one copy of the Document Database program.    This can be accomplished by specifying the 
full path name (drive, directory, and file name) of your data file on the command line used to start the 
Document Database program.    

For example, the normal command line used to start Document Database is:
C:\DOCDB\DOCDB.EXE

Note that there is nothing on the command line after the program name DOCDB.EXE. 

If you have a second Document Database data file in another directory called MYNAME, then you can 
use the following command line to start Document Database using this second database file:

C:\DOCDB\DOCDB.EXE    C:\MYNAME\DOCDB.MDB
Note that the location and name of the DOCDB.MDB database file is listed on the command line after the 
program name.    The program location and name is the same, but by specifying the location and name of 
the database file DOCDB.MDB after the program name, Document Database uses the database in 
directory MYNAME rather than the one in directory DOCDB.

Similarly, you can specify the location of the DOCDB.MDB file on your LAN file server if you want several 
people to share the same data.

The command line referred to above is located in the Program Item Properties window in the Microsoft 
Windows Program Manager.    If you have never created a new Program Item or never changed Program 
Item Properties in Windows, you should enlist the help of someone more experienced with Windows, or 
refer to your Windows Users Manual.



Repair Database

In the unlikely event that your database is damaged, you can attempt to repair it by clicking on the Repair 
Database icon in the Document Database program group.

A database can become damaged due to a sudden loss of computer power while the program is 
performing an update operation.    A computer hardware problem can also cause damage.

Only certain types of problems can be corrected by the repair program.    Therefore, make sure you 
always have a recent backup copy of your DOCDB.MDB file.



Reports

To print reports, click the Reports button or select the Reports menu.    A list of available reports will be 
displayed.    Select the report you want from the list by clicking it with the mouse.    To print only one or just
a few records on a report, see the topic Selecting Records.



Selecting Records

If you want to display or print specific records by individually choosing each record from a larger list, you 
can do this easily.    Just position the mouse cursor to the extreme left of the Grid on the record you want 
to select.    The mouse cursor will change to a check mark when it is positioned in the correct spot.    Then 
simply click the mouse once and that record will be selected.    You can then display just the selected 
records by pressing the button which says: "Show Selected Records Only".    The Edit menu has 
additional options for hiding all selected records and for removing all selection marks.

Only those records displayed on the Grid will print on all reports.    Therefore, by selecting records, you 
can easily print a report that includes only the records you want.



Show All Records

To display all records in your Document Database data file, click the Show All button.    This is useful if 
you previously limited the records displayed by choosing a specific Category, or by specifying a Filter or 
Selecting Records.



Sorting

To sort your list of names in a different order, just click on the "Sort by" box on the main screen (the 
screen with the menu and picture icons).    A list will appear showing most of the fields in the database.    
Select a field name by clicking it with the mouse.    Your list will then be rearranged based on the contents 
of the field you selected.

Any labels and reports will print in the current sort order.



Specify Font for Notes

Note: The following applies only to the   Notes   field, not to the data you enter in the word processing   
section.

To change the font name and the font size used to display and print your Notes data, choose the option 
"Specify Font for Notes" from the Document Database Edit menu.    A screen will appear that lets you 
choose from all available Windows fonts.

If you need to arrange your Notes data in columns, you should choose a fixed-width font such as 
Courier New.    With fixed-width fonts, every character is exactly the same width.    This makes it easier 
to align text.    If you do not want the text on a line to be combined with another line when printed, you 
must insert a carriage return at the end of that line when you add your data.    You do this by simply 
pressing the Enter key after the cursor is positioned past the last character on that line.

If you don't insert a carriage return after each line, then that line may be combined with the next line when
your data is printed, which allows more text to print on each line.

If you want your columns of data to always be aligned when you print, you must use a fixed-width font and
you should use spaces rather than tabs to separate columns.    You also must use carriage returns (the 
Enter key) to end each line.    If you need this much flexibility, you should probably use the word 
processing section for this data, not the Notes field.

In the Notes field, you should choose one font name and one font size and then stick to it.    Changing 
either of these will change the alignment of any columns, and will change the position where a line wraps 
to a new line.

Once again, the preceding discussion applies only to the   Notes   field, not to the text you enter in the big   
word processing section which takes up most of the screen.    In the word processing section, you have 
much   more flexibility.    You can mix as many different fonts as you want in each document, and it will   
print almost exactly like it appears on your screen.



View/Edit or Add a record

To View or Edit an existing record in the database, double-click the row on the Grid which displays the 
desired record, or click the View/Edit button.    The next screen which appears displays and lets you 
change all the data for the selected record.    This screen is referred to as The Edit screen.    Jump to that 
topic for more information

To Add a new record to the database, click the Add button.    The next screen which appears allows you 
to add new data for all the fields in a record.    This screen is also referred to as The Edit screen.




